
 

Straight ahead and pose to pose animation  

This rule portrays two strategies used to animate drawings.  

The main technique is drawing the principal drawing and then moving on to the second 

drawing and so on. Then, sequentially arrange them by outlining from the beginning. The second 

technique is ‘pose to pose’ in which you draw the starting and end of every principle pose and 

later on fill in the drawings at the middle called in-between poses. There are advantages to these 

two strategies but ‘pose to pose’ is by far better for most activities since it gives the maximum 

control to what the activity will resemble. Utilizing straight ahead animation can prompt the 

character evolving size, or being on an alternate level from start to finish whereas pose to pose 

technique spares a considerable measure of work. On the off chance, animate an entire grouping 

straight ahead and then understand that one pose is off. You would need to change few drawings 

to settle that one pose. In pose to pose technique, you would do the fundamental poses to check 

whether it feels right and if you can get issues at an opportune time straight ahead animation. It is 

also useful for animation, which is flighty. A few cases of this incorporates fire, water, particles, 

dust and storms blasts explain the motivation behind straight ahead functions, which admirably is 

on the grounds that there are laws of material science that work at a steady rate and it is difficult 

to foresee them. Another method is animate using pose to pose, then going through, and adding 

the years using straight ahead. This is good because you can focus on the figures’ movements 

without the distraction of having to do it and you can focus on the physics of the particular 

movement without the distraction of his body's movement. 

 

key frames in animation 

 

To create an action in a digital animation sequence, you first need to define the start and end 

points for that action. These markers are called keyframes, and they're used as anchor points for 

actions in all different types of animation programs, including Adobe After Effects, Animate, 

and Character Animator. 



Keyframe Characteristics: 

 Important individual frames from within a shot 

 Keyframes exist in animation and live-action 

 Sets a start/stop point for a transition 

 

Motion paths in animation 

Motion paths let you animate objects moving along curves and complex shapes. Similarly to 

lines drawn with the pen tool, you define motion paths by setting anchor points which are then 

connected by straight or curved lines. 

Motion path animation is approximated by CSS, so animated elements may not exactly follow 

their motion paths. Generally the difference shouldn't be noticeable (by default, less than a 

pixel), and you can limit the extent of the deviation in the motion path properties. 

Viewing motion paths 

Select a single element or group to see lines indicating where it will move during animation, 

along with the anchor points. 

 

You can only view one motion path at a time. 

Anchor points 

Anchor points are set by two ways: 

 Thumbnails or keyframes that specify a new x or y position for the element 

automatically generate anchor points. The starting and ending anchor points are always 

at keyframes. 

 You can add anchor points along the motion path using the Motion path tool. 

Control handles 

Control handles are visible when the Motion path tool  is selected. Each segment between 

anchor points has two control handles, one attached to each anchor point. The length and 

direction of a control handle indicate the degree of the motion path's curvature. For straight 

lines, control handles lie flush against the segment or are collapsed. 

https://support.google.com/webdesigner/answer/3241082#curved


 

Editing motion paths 

Editing motion path shape 

Motion paths can be simple curves, closed shapes such as polygons and circles, or detailed 

outlines of other objects. To change the shape of a motion path: 

Add an anchor point 

 Add a thumbnail or keyframe that changes the position of the element. This adds an 

anchor point where you can change the easing. 

 The Add anchor point option  of the Motion path tool  lets you click a spot on the 

motion path to add an anchor point, fixing the motion path there. Adding an anchor point 

using this method doesn't add a thumbnail or keyframe. 

Adjust the curvature 

 When the Selection tool or the default option  for the Motion path tool  is selected, 

drag any spot on the motion path -- including anchor points -- to change the shape of the 

path. 

 When the Motion path tool  is selected, drag the control handles to change their 

length and angle, affecting the motion path's curvature. If another control handle is 

attached to the same anchor point, the other control handle automatically adjusts its 

angle to match unless you hold down the Alt key. 

 Double-click an anchor point to collapse the attached control handles. Double-clicking 

again extends the control handles. 

To straighten a motion path, double-click both anchor points. 

Delete an anchor point 

 The Delete anchor point option  of the Motion path tool  lets you remove an 

existing anchor point by clicking it. Deleting an anchor point corresponding to a 

thumbnail or keyframe without any animated properties other than the motion path also 

deletes the thumbnail or keyframe. 

 Deleting a thumbnail or keyframe deletes the segment of the motion path that ends at 

that thumbnail or keyframe. 



Transforming motion paths 

You can move, resize, flip, or rotate motion paths by selecting the Motion path tool  then 

checking the Transform control box in the tool options bar. With this option enabled, the 

transform controls display when you select an element with a motion path. 

 

Move a motion path 

Drag the motion path to a new position on the stage. 

Resize the motion path 

 The resize box borders the motion path in blue, with handles at each corner and on each 

side. Drag a handle to change the size of the motion path. 

 Hold the Shift key while dragging to maintain the original aspect ratio. 

 Hold the Alt key while dragging to keep the motion path centered at the same spot. 

 To resize the motion path in a different direction, rotate the resize box by entering the 

degrees of rotation in the field  in the tool options bar. You can also hold Alt (Windows) 

or Option (Mac) while pressing the left or right arrow key to rotate the resize box by 5°. 

The field always resets to 0°, so you should enter the desired rotation from the current 

orientation. Rotating the resize box doesn't change the orientation of the motion path 

itself. 

 To reset the resize box orientation, double-click the inner rotation control (the smaller 

ring). This also resets the rotation pivot point location. 

Flip the motion path 

 Drag a resize handle over the opposite resize handle. 

Rotate the motion path 

 Drag the outer rotation control (the larger ring) clockwise or counterclockwise to rotate 

the motion path. 

 Hold the Shift key while dragging to constrain the rotation to 45° increments. 

 To move the pivot point for the rotation, drag the inner rotation control (the smaller ring) 

to a different place. Reset the pivot point location by double-clicking the inner rotation 

control (this also resets the resize box orientation). 



 

Motion Path Editing - Google Web Designer 

 

Editing animation speed 

Control the speed of an object along its motion path by changing the timing of the thumbnails or 

keyframes and the easing between them. You can also loop motion path animation. 

Anchor points added with the motion path tool don't affect animation speed. Add a thumbnail or 

keyframe instead. 

Optimization 

Whenever you create or edit a motion path, Google Web Designer automatically optimizes the 

animation, reducing the amount of CSS used to render it while observing the tolerances you 

specify in the motion path properties. The lower the tolerances, the closer the animation follows 

the motion path, but less optimization is possible. 

For additional compression, click Optimize curve  in the motion path properties. This 

process can take more time than automatic optimization. 

Google Web Designer displays the estimated size of the selected element's motion path in the 

Properties panel, reflecting how much disk space the motion path will take after publishing the 

document. 

Motion path properties 

Motion path properties appear in the Properties panel once you add an anchor point with 

the Motion path tool or edit the motion path to curve. 

 

Property Description 

https://www.youtube.com/watch?v=rltu7O1PPi8
https://www.youtube.com/watch?v=rltu7O1PPi8
https://support.google.com/webdesigner/answer/3227667


Property Description 

Orient to path When enabled, the element rotates during animation to face the direction 

of the motion path (e.g., while following the downward curve of a motion 

path, the element tilts downward). Control the precision of the rotation 

with the Angle tolerance property. 

Position tolerance Sets how far the element can deviate from the motion path. 

 Default: 0.5px 

 Minimum: 0.1px 

 Maximum: 100px 

Angle tolerance Controls how much the element's orientation can differ from the motion 

path's orientation. Only applicable if the Orient to path option is 

enabled. 

 Default: 1° 

 Minimum: 1° 

 Maximum: 360° 

Optimize curve Click the  button to reduce the size of the CSS used to generate the 

motion path animation. After optimization, the button is disabled until the 

motion path changes. 

Size estimate Displays an estimated size of the motion path. For additional 

compression, use the Optimize curve button. 

Limitations 

 Top/left positioning - Motion paths don't support top/left positioning. Use the 

CSS transform property instead (this is the default). 

 3D animation - Google Web Designer doesn't support 3D motion paths. You can 

apply 3D translations separately to the element. 

 CSS panel - The CSS panel doesn't affect motion paths, although styles are still applied 

to the element itself. 

 Code view - You can't view or edit motion paths in Code view. 

 Image ads - The motion path tool is unavailable in image ads. 

Applying geometric transformation over time 

Transformation means changing some graphics into something else by applying rules. We can have various 
types of transformations such as translation, scaling up or down, rotation, shearing, etc. When a transformation 
takes place on a 2D plane, it is called 2D transformation. 

https://support.google.com/webdesigner/answer/6319682
https://support.google.com/webdesigner/answer/3265318
https://support.google.com/webdesigner/answer/3329551
https://support.google.com/webdesigner/answer/3187123
https://support.google.com/webdesigner/answer/10994514


Transformations play an important role in computer graphics to reposition the graphics on the screen and 
change their size or orientation. 

Homogenous Coordinates 

To perform a sequence of transformation such as translation followed by rotation and scaling, we need to follow 
a sequential process − 

 Translate the coordinates, 

 Rotate the translated coordinates, and then 

 Scale the rotated coordinates to complete the composite transformation. 

To shorten this process, we have to use 3×3 transformation matrix instead of 2×2 transformation matrix. To 
convert a 2×2 matrix to 3×3 matrix, we have to add an extra dummy coordinate W. 

In this way, we can represent the point by 3 numbers instead of 2 numbers, which is called Homogenous 
Coordinate system. In this system, we can represent all the transformation equations in matrix multiplication. 

Any Cartesian point PX,Y can be converted to homogenous coordinates by P’ (Xh, Yh, h). 

Translation 

A translation moves an object to a different position on the screen. You can translate a point in 2D by adding 

translation coordinate (tx, ty) to the original coordinate X,Y to get the new coordinate X′,Y′. 

 

From the above figure, you can write that − 

X’ = X + tx 

Y’ = Y + ty 

The pair (tx, ty) is called the translation vector or shift vector. The above equations can also be represented 
using the column vectors. 

P=[X][Y] p' = [X′][Y′]T = [tx][ty] 

We can write it as − 

P’ = P + T 

Rotation 

In rotation, we rotate the object at particular angle θ theta from its origin. From the following figure, we can see 

that the point PX,Y is located at angle φ from the horizontal X coordinate with distance r from the origin. 

Let us suppose you want to rotate it at the angle θ. After rotating it to a new location, you will get a new point 

P’ X′,Y′. 

 

Using standard trigonometric the original coordinate of point PX,Y can be represented as − 

X=rcosϕ......(1) 

Y=rsinϕ......(2) 

Same way we can represent the point P’ X′,Y′ as − 

x′=rcos(ϕ+θ)=rcosϕcosθ−rsinϕsinθ.......(3) 

y′=rsin(ϕ+θ)=rcosϕsinθ+rsinϕcosθ.......(4) 



Substituting equation 1 & 2 in 3 & 4 respectively, we will get 

x′=xcosθ−ysinθ 

y′=xsinθ+ycosθ 

Representing the above equation in matrix form, 

[X′Y′]=[XY][cosθ−sinθsinθcosθ]OR 

P’ = P . R 

Where R is the rotation matrix 

R=[cosθ−sinθsinθcosθ] 

The rotation angle can be positive and negative. 

For positive rotation angle, we can use the above rotation matrix. However, for negative angle rotation, the 
matrix will change as shown below − 

R=[cos(−θ)−sin(−θ)sin(−θ)cos(−θ)] 

=[cosθsinθ−sinθcosθ](∵cos(−θ)=cosθandsin(−θ)=−sinθ) 

Scaling 

To change the size of an object, scaling transformation is used. In the scaling process, you either expand or 
compress the dimensions of the object. Scaling can be achieved by multiplying the original coordinates of the 
object with the scaling factor to get the desired result. 

Let us assume that the original coordinates are X,Y, the scaling factors are (SX, SY), and the produced 

coordinates are X′,Y′. This can be mathematically represented as shown below − 

X' = X . SX and Y' = Y . SY 

The scaling factor SX, SY scales the object in X and Y direction respectively. The above equations can also be 
represented in matrix form as below − 

(X′Y′)=(XY)[Sx00Sy] 

OR 

P’ = P . S 

Where S is the scaling matrix. The scaling process is shown in the following figure. 

 

If we provide values less than 1 to the scaling factor S, then we can reduce the size of the object. If we provide 
values greater than 1, then we can increase the size of the object. 

Reflection 

Reflection is the mirror image of original object. In other words, we can say that it is a rotation operation with 
180°. In reflection transformation, the size of the object does not change. 

The following figures show reflections with respect to X and Y axes, and about the origin respectively. 

 



Shear 

A transformation that slants the shape of an object is called the shear transformation. There are two shear 
transformations X-Shear and Y-Shear. One shifts X coordinates values and other shifts Y coordinate values. 
However; in both the cases only one coordinate changes its coordinates and other preserves its values. 
Shearing is also termed as Skewing. 

X-Shear 

The X-Shear preserves the Y coordinate and changes are made to X coordinates, which causes the vertical 
lines to tilt right or left as shown in below figure. 

 

The transformation matrix for X-Shear can be represented as − 

Xsh=⎡⎣⎢100shx10001⎤⎦⎥ 

Y' = Y + Shy . X 

X’ = X 

Y-Shear 

The Y-Shear preserves the X coordinates and changes the Y coordinates which causes the horizontal lines to 
transform into lines which slopes up or down as shown in the following figure. 

 

The Y-Shear can be represented in matrix from as − 

Ysh⎡⎣⎢1shy0010001⎤⎦⎥ 

X’ = X + Shx . Y 

Y’ = Y 

Composite Transformation 

If a transformation of the plane T1 is followed by a second plane transformation T2, then the result itself may be 
represented by a single transformation T which is the composition of T1 and T2 taken in that order. This is 
written as T = T1∙T2. 

Composite transformation can be achieved by concatenation of transformation matrices to obtain a combined 
transformation matrix. 

A combined matrix − 

[T][X] = [X] [T1] [T2] [T3] [T4] …. [Tn] 

Where [Ti] is any combination of 

 Translation 

 Scaling 

 Shearing 

 Rotation 

 Reflection 



The change in the order of transformation would lead to different results, as in general matrix multiplication is 
not cumulative, that is [A] . [B] ≠ [B] . [A] and the order of multiplication. The basic purpose of composing 
transformations is to gain efficiency by applying a single composed transformation to a point, rather than 
applying a series of transformation, one after another. 

For example, to rotate an object about an arbitrary point (Xp, Yp), we have to carry out three steps − 

 Translate point (Xp, Yp) to the origin. 

 Rotate it about the origin. 

 Finally, translate the center of rotation back where it belonged. 

 

Intertwining options 

 the Intertwine feature in Illustrator to overlap objects in dynamic new ways. You can intertwine different 

shapes, text, and 3D and 2D objects and edit them.  

Intertwine shapes 

 
 

Intertwine type objects 



 
Intertwine shapes with type objects 

 

Edit intertwined objects 

 

Release intertwined objects 

Create intertwined objects 

To intertwine objects, follow these steps: 

https://helpx.adobe.com/in/illustrator/using/intertwine-objects.html#edit-intertwined-objects
https://helpx.adobe.com/in/illustrator/using/intertwine-objects.html#release-intertwined-objects


1. Select the Selection  tool from the toolbar. 

2. Select the objects that you want to intertwine. 

3. Select Object > Intertwine > Make.  

4. Draw an enclosed path around the sections of the objects that you want to intertwine. To make a 

rectangular selection, press Shift while you draw. 

Try it in-app! 

Watch the animation and practice intertwining objects using a sample file. 

Open in Illustrator 

5. To intertwine objects with more than two overlapping paths, view the highlighted boundary by 

hovering over the enclosed area. Right-click the highlighted boundary and select Bring to 

Front, Bring Forward, Send Backward, or Send to Back to arrange the order of the Intertwine. 

 
 

View the highlighted boundaries 

 
Arrange the order of the Intertwine 

 

 

https://creativecloud.adobe.com/campaign/illustrator?workflow=launch&id=2022-12-intertwine&vid=test&min-version=27.1&uri=adbai%3A%2F%2Fapp%2Fv1%3Fconsumer.name%3DHelpX%26exp.campaign_id%3D2022-12-intertwine%26exp.variation_id%3Dtest%26source.name%3DILST%26source.version%3D27.1%26content.type%3DcmHelpXDetail%26content.id%3Dillustrator%252Fusing%252Fintertwine-objects%26content.name%3DIntertwine%2520objects%26sampleFile%3Dhttps%253A%252F%252Fcc-cdn.adobe.com%252Fcontent%252Fgrowth%252FtemplateImages%252Fsample-file-intertwine.ai%26action%3DLearnAndSearch%26env.com.name%3DUnified-Panel


Edit intertwined objects 

If you want to modify intertwined objects, you have to re-enable the Intertwine option. Follow these steps to 

re-enable Intertwine and edit intertwined objects: 

1. Select the intertwined objects. 

2. Select Object > Intertwine > Edit. 

Release intertwined objects 
1. Select the intertwined objects. 

2. Select Object > Intertwine > Release.  

 

Tips and tricks 
Here are a few things to keep in mind while working with Intertwine: 

 Objects are grouped in the Layers panel. You can drag other layers into grouped objects. 

 You can also access Edit and Release options in the Properties panel or the Control bar. 

 Intertwine does not work with Live Paint, Repeat, and Graphs. 

 Illustrator does not support creating nested intertwines or intertwines from already intertwined objects. 

Looping and palindrome motion 

Loop animations 
Looping an animation causes it to repeat. You can loop animations in Advanced mode. Each element's animation can be looped 

separately, or you can loop a more complex animation involving multiple elements. 

Loop the animation for a single element 

1. On the timeline, click the Set animation repeat  button on the animation layer that you want to loop. 

2. In the pop-up menu, select an option: 

 Infinite - The animation loops infinitely. 

 ___ times - The animation loops to play the specified number of times in total. 

 None - The animation does not loop. 

Looped keyframes show as translucent copies on the timeline. In the example below, the red-div element has a 0.5-second-long animation that 

loops to play 4 times in total. 

 

You can preview the looped animation on the stage by clicking Play  in the timeline. 

https://helpx.adobe.com/in/illustrator/using/grouping-expanding-objects.html
https://helpx.adobe.com/in/illustrator/using/live-paint-groups.html
https://helpx.adobe.com/in/illustrator/using/repeat-patterns.html
https://helpx.adobe.com/in/illustrator/using/graphs.html
https://support.google.com/webdesigner/answer/7529849


Loop the animation for multiple elements 

You can add an event to loop all animation on the page, starting and ending at the times you specify. 

1. Set a timeline label where you want the animation loop to start: 

1. Right-click the Events track (the first row of the timeline) where you want the animation to start looping, and select Add 

label... from the pop-up menu. 

2. Enter a label name such as loopStart in the pop-up dialog. 

3. Press Enter. 

2. Right-click the Events track where you want the animation loop to end, and select Add event from the pop-up menu. 

 

3. Double-click the event marker  to configure the event: 

1. For the Action, choose: 

 Timeline > gotoAndPlay for infinite looping. 

 Timeline > gotoAndPlayNTimes for a specific number of loops. 

2. For the Receiver, choose the page. 

3. For the Configuration, select the label you created earlier (for example, loopStart) and set the number of times you 

want to repeat. 

Use the Preview  button to see how your looped animation behaves in a browser. 

 

Features specific to the program in use-2D animation application software interface 

1. Toon Boom Harmony 

If you want to create narrated animations for films, web or TV, then Toon Boom Harmony is a 
must-have animation tool. Toon Boom is paid professional software used for shows like The 
Simpsons, Rick and Morty, Futurama, Bob's Burgers, and Klaus to name just a few. 

The software takes time to master, but once you learn it, you can take advantage of 

advanced features to create really neat animations. As it's the tool of choice of many 

studios, it's what we teach in our 2D animation course.  

Features of Toon Boom Harmony include: 

 Bitmap drawing, vector drawing and painting tools. 

 Tools for scanning and cleaning up traditional paper drawings. 

https://www.toonboom.com/products/harmony


 Advanced rigging and deformer tools to animate puppets. 

 Powerful compositing tools so you don't have to export your work somewhere else to add visual 
effects. 

 3D stage for setting up multi-plane environments. 
The learning curve is steep so it can take a little more time to learn animation with this tool. 
However, if you're planning on getting into animation professionally, Toon Boom is definitely 
worth pursuing! 

 
Rick and Morty was animated using Toon Boom 2D animation software 

2. Synfig Studio 

Synfig Studio is a free cross-platform software. It is both a back-end and front-end application 
meaning that you can create your animation and render it in the back-end later. 

https://www.cgspectrum.com/blog/what-is-compositing
https://www.cgspectrum.com/courses/2d-animation-course
https://www.synfig.org/


There are two versions of Synfig Studio software. One is a development version and the other a 
stable version. The stable version comes with fine-tuned features making it safe for use 
by amateur animators. Advanced users can switch to the development version for a taste of 
newly added features. 

Synfig Studio is ideal for use by a solo artist or a small team of artists. It speeds up 

animation creation by use of digital tweening and sprites in place of traditional 

tweening. 

Other features of Synfig Studio include: 

 Various types of layers (geometric, fractals, gradients, etc) so you can create both simple and 
complex animations. 

 Bone system for creating cut-out animations. 

 Several drawing tools, plus the ability to do your artwork elsewhere and import it into Synfig.  

 Animation is easily done by simply pressing record and manipulating your object. 

 An integrated soundtrack. 

The downside is that for beginners, there aren't so many online tutorials teaching how to use the 
software. 

2D animation filmmaker & CG Spectrum mentor Sykosan shares what it was like to direct and animate Katy 
Perry’s Cry About it Later music video. 

3. Pencil 2D 

The multifaceted Pencil 2D animation software is a cross-platform open-source program that 
allows the use of sketch ink and paint. 

The first version of Pencil 2D came out over a decade ago, and the software has grown a lot 
since then. The interface is more modern and there are more features including coloring options 
that help you create some interesting projects. 

Pencil 2D is still based on traditional animation and doesn't allow for tweening (the process of 
creating the intermediate frames in between the keyframes to create smoother, more seamless 
movement). That said, it is quite flexible and once you have mastered the keyboard shortcuts you 
will be creating cartoons in no time. 
Features of Pencil 2D: 

 Minimalistic user interface so you can concentrate on animating and not which tab to click next.  

 Raster and vector workflows so you can sketch ink and paint simultaneously. 

 Tagged Image File Format (TIFF) is supported, and you can add new layers on frames by 
importing images on them. 

 

ANIMATION 
7 minute read 

https://www.cgspectrum.com/career-pathways/animation
https://www.pencil2d.org/
https://www.cgspectrum.com/blog/what-is-2d-animation
https://www.cgspectrum.com/blog/what-is-2d-animation
https://www.cgspectrum.com/blog/what-is-2d-animation
https://www.cgspectrum.com/blog/what-is-2d-animation


What is 2D animation? Everything you need to know 

 
By Nadia Stefyn 
 

Get articles like this in your inbox every month 

Plus artist interviews, free resources, career advice and special offers from CG Spectrum's film 

and game experts! 

4. OpenToonz 

OpenToonz is another open-source software option. It is the free version of Toonz, which has 
been used in big projects like Studio Ghibli's Princess Mononoke. 

Just like the paid version, OpenToonz is great to use. It combines both traditional drawing and 2D 
animation and has many features (dynamic palette, tweening coloring, bitmap tools, etc). 

OpenToonz is good animation software for beginners. To animate a drawing, you just have to 
scan it. You can also plug-in SDK effects and change picture styles using artificial intelligence. 

Features of OpenToonz: 

 Open-source and free for use in commercial and non-commercial projects. 

 Compatible with TWAIN standards. 

 Works with both vector and raster images. 

 Allows for 4 types of scanning, and you can save scan settings for future use. 

https://www.cgspectrum.com/blog/what-is-2d-animation
https://www.cgspectrum.com/blog/what-is-2d-animation
https://www.cgspectrum.com/blog/what-is-2d-animation
https://www.cgspectrum.com/blog/what-is-2d-animation
https://opentoonz.github.io/e/


Studio Ghibli's Princess Mononoke (1997) was animated in Toonz, which has a free version called OpenToonz  

5. Moho Pro 

Vector-based 2D animation software Moho Pro is known for its great bitmap capabilities. It also 
comes with features that allow for freehand drawing. However, it is not very beginner-friendly, 
and can take some time to get the hang of. 
Moho Pro is supported by both Windows and OSX. It's paid software, but the advantage is that 
you get an all-in-one animation studio for both your 2D and 3D projects. Moho Pro is not 
beginner-friendly, and it can take some time to get the hang of. 
The software has evolved to include features such as: 

 Tweening of vector shapes and bone animations. 

 Smart bone technology to clean distortions in your animations. 

 Soundtracks you can add to your animation. 

https://my.smithmicro.com/moho-pro.html
https://www.cgspectrum.com/blog/2d-vs-3d-animation


 Inbuilt bitmap brush for freehand drawing. You can control the velocity; pressure and direction of 
brush output to achieve natural-looking strokes. 

 New action window where a combination of keywords, sub-words and boolean operations can be 
used to filter and search actions. 

6. TupiTube 

Maefloresta's TupiTube is free animation software that is compatible with android and iPhone. 
You can install the app on your Android smartphone or iOS to start creating fun 2D videos to 
share with your friends. It's pretty basic, but it's easy to get started. 
Features of TupiTube include: 

 A beginner-friendly intuitive interface. 

 A free downloadable app for Android and iOS devices. 

 Plenty of free tutorials on how to use the software 

7. Adobe Animate 

Adobe Animate is paid software from the classic Adobe suite. It has features that support both 
audio and video embedding, raster graphics, rich text, as well as ActionScript scripting. 
Adobe Animate improves on the legacy of the original Adobe Flash. It is easy to use, you don't 
need as much guidance to pick up the basics and create your fun 2D videos, though it won't hurt 
watching a few tutorials first. 

Animate has been lauded for its features which allow the creation of interactive animations. If you 
want to animate website elements, animate is the tool of choice. You can use it to create 
animations for HTML5 Canvas, SVG animation, WebGL, etc. 

Features include: 

 Vector brushes to create natural brushstrokes. 

 Export format to publish creation to any platform. 

 Virtual camera for realistic views. 

 Audio syncing. 

 Typekit tool so you can use various web fonts. 

 Modern timeline where you can edit frames, highlight letters, and more. 
So, to you budding 2D animators, there's our list of animation software. While there are many 
other options on the market, the best 2D animation software really depends on what you want 

to use it for.  

If you're just starting out, try the free tools first to see if you enjoy animating. But if you 

want to become a professional animator, consider learning the 2D software the 

animation studios you want to work for are using. 

 

https://www.maefloresta.com/
https://www.cgspectrum.com/courses/advanced-2d-animation-course
https://www.adobe.com/au/products/animate.html
https://www.cgspectrum.com/courses/2d-animation-course
https://www.cgspectrum.com/career-pathways/2d-animator


Default setting and user preferences 

You can set preferences for general application operations, editing operations, code and compiler operations, 

and drawing and text options. 



 



The General category in the Preferences dialog box. 

Set preferences 
1. Select Edit > Preferences (Windows) or Animate > Preferences (Macintosh). 

2. Make a selection in the Category list and select from the respective options. 

Set General preferences 

On Launch 

Specify which document opens when you start the application. 

Document- or Object-level undo 

Document-level undo maintains a single list of all your actions for the entire Animate document. Object-level 

undo maintains separate lists of your actions for each object in your document. Object-level lets you undo an 

action on one object without having to also undo actions on other objects that might have been modified more 

recently than the target object. 

Undo levels 

To set the number of undo or redo levels, enter a value from 2 to 300. Undo levels require memory; the more 

undo levels you use, the more system memory is consumed. The default is 100. 

Auto-Recovery 

When enabled (the default setting), this setting saves a copy of each open file at the specified time interval, in 

the same folder as the originals. If you have not saved the file yet, Animate saves the copies in its Temp folder. 

The file names are the same as the originals, with “RECOVER_” added to the beginning of the file name. If 

Animate quits unexpectedly, a dialog box appears when you restart to allow you to open the auto-recover file. 

When you exit Animate normally, the auto-recover files are deleted. 

Starting Animate 2015 release, Animate does not create unnecessary auto-recovery files. An auto-recovery file 

is created only if the document is modified after the last auto-recovery files were created. Auto-recovery file is 

removed only after completing a successful save operation. To avoid continuous loop of auto-recovery for short 

auto-recovery duration, snapshot for all files modified after last auto-recovery are created at each auto-

recovery interval. Next auto recovery timer is started only after this process is completed.  

User Interface 

Select your preferred user interface style, between Dark or Light. To apply shading to the user interface 

elements, select Enable Shading. 

Workspace 

To have panels in icon mode auto collapse when you click outside them, select Auto-Collapse Icon Panels. To 

open a separate window when you select Control > Test, select Open Animate and Script Documents in 

Separate Windows. The default is to open the test movie in its own window. 

Highlight Color 

To use the current layer’s outline color, select a color from the panel, or select Use Layer Color. 



Set Sync Settings preferences 

In the Sync Settings tab, you can specify the settings for synchronizing Animate with your Creative Cloud 

account and libraries. 

 
Sync Settings tab in the Preferences dialog box 

Adobe ID 

This displays the Adobe ID using which you have signed in to your Creative Cloud account and the date and 

time the last sync with your Creative Cloud account was done. 

 To view your Creative Cloud profile and library, or to log in using a different Adobe ID, click Manage Account. 

 To sync your settings, click Sync Settings Now. 

Sync Options 

This displays the sync options that you have set between Animate and your Creative Cloud account. You can 

sync your application preferences; workspaces; default document settings; keyboard shortcuts; grid, guides, and 

snapping settings; sprite sheet settings; variable width profiles, and custom brushes. 

 Sync: Set the sync preferences by choosing among All (sync all the settings), Custom (sync the settings that you 

have selected from the options displayed below), or Disabled (disable all syncing). 

 To sync your settings with your Creative Cloud settings, click Sync Settings Now. 

To learn about synchronizing preferences to Creative Cloud, and across multiple machines, see Sync Animate 

Preferences with Creative Cloud 

https://helpx.adobe.com/flash/using/sync-pref-flashpro-with-cc.html
https://helpx.adobe.com/flash/using/sync-pref-flashpro-with-cc.html


To learn more about working with Creative Cloud libraries, see Creative Cloud libraries. 

Set Code Editor preferences 

In the Code Editor tab, you can set how you want your code to be displayed in Animate. 

https://helpx.adobe.com/creative-cloud/help/libraries.html


 



Code Editor tab in the Preferences dialog box 

Under Editing Options, you can change the defaults for the following: 

 Font: Set the font and font size. 

 Style: Choose between regular, italic, bold, or bold italic. 

 Modify Text Coloring: Click this button to set text color for foreground, background, keywords, comments, 

identifiers, and strings. 

 Automatic code brace: Enabled by default. All code braces are closed by default. 

 Automatic indentation: Enabled by default. Turn it off if you do not want code indentation. 

 Code hints: Enabled by default. Clear the checkbox if you do not want code hints to come up as you type code. 

 Cache Files: Set the limit for the cache files. Default is 800. 

 Tab size: The default size of the code tab is set to 4. Enter a value if you want to resize it. 

Under Format Code, you can set the following preferences and check the preview pane for how the changes 

are applied to your code: 

 Script Language: Select the default script language as ActionScript or JavaScript. A sample code is displayed as 

you select an option. 

 Brace style: Select your preferred brace style, either in the same line as control statements, in a separate line, or 

only the end braces in a separate line.  

 Break chained methods: Select it to display code lines as broken up logically. 

 Keep array indentation: Select to keep the arrays indented logically. 

 Keep space after keywords: Selected by default. Change it if you do not want a space after each keyword. 

Set Script Files preferences 

The Script Files tab allows you to set the import options for the script files: 

Open: Select UTF-8 Encoding to open or import using Unicode encoding, or select Default Encoding to open or 

import using the encoding form of the language currently used by your system. 

Reload modified files: Specifies what happens when a script file is modified, moved, or deleted. Select Always, 

Never, or Prompt. 

 Always: No warning is displayed, and the file is automatically reloaded. 

 Never: No warning is displayed, and the file remains in the current state. 

 Prompt(Default): A warning is displayed, and you can choose whether to reload the file. 

When you build applications with external scripts, this preference helps you avoid overwriting a script that a 

team member has modified since you opened the application, or avoid publishing the application with older 

versions of scripts. The warnings let you automatically close a script and reopen the newer, modified version. 

Class editor: Select the editor for editing classes. The options are Animate, Flash Builder, or Ask. 

Set Compiler preferences 



The Compiler tab in the Preferences dialog box allows you to set the following compiler preferences for the 

language you have selected. You can browse to a path or a SWC file or specify a new path: 

 SDK path: The path to the folder containing bin, frameworks, lib, and other folders. 

 Source path: The path to the folders containing ActionScript class files. 

 Library path: The path to SWC files or folders containing SWC files. 

 External library path: The path to the SWC files used as runtime shared libraries. 

Set Text preferences 

You can specify the following preferences for text display the Text tab: 

 Default Mapping Font 

 Style 

 Show font name language 

 Show font preview 

 Font preview size 

Set Drawing preferences 

Pen tool: Lets you set options for the Pen tool. Select Show Pen Preview to display a preview line from the last 

clicked point to the current location of the pointer. Select Show Solid Points to display control points as small 

filled squares instead of unfilled squares. Select Show Precise Cursors to display a crosshair cursor instead of the 

Pen tool icon when using the Pen tool. This option lets you see the exact target of clicks more easily. 

IK Bone Tool: Autoset Transformation Point is selected by default for the Bone Tool. 

Connect lines: Determines how close the end of a line being drawn must be to an existing line segment before 

the end point snaps to the nearest point on the other line. This setting also controls horizontal and vertical line 

recognition—that is, how nearly horizontal or vertical a line must be drawn before Animate makes it exactly 

horizontal or vertical. When Snap To Objects is turned on, this setting controls how close objects must be to 

snap to one another. 

Smooth curves: Specifies the amount of smoothing applied to curved lines drawn with the Pencil tool when 

the drawing mode is set to Straighten or Smooth. (Smoother curves are easier to reshape, whereas rougher 

curves match the original line strokes more closely.) 

 To further smooth existing curved segments, use Modify > Shape > Smooth and Modify > Shape > Optimize. 

Recognize lines: Defines how nearly straight a line segment drawn with the Pencil tool must be before 

Animate recognizes it as a straight line and makes it perfectly straight. If Recognize Lines is off while you draw, 

straighten lines later by selecting one or more line segments and selecting Modify > Shape > Straighten. 

Recognize shapes: Controls how precisely to draw circles, ovals, squares, rectangles, and 90° and 180° arcs for 

them to be recognized as geometric shapes and redrawn accurately. The options are Off, Strict, Normal, and 

Tolerant. Strict requires that the shape be drawn very close to straight; Tolerant specifies that the shape can be 

somewhat rough, and Animate redraws the shape. If Recognize Shapes is off while you draw, straighten lines 



later by selecting one or more shapes (for example, connected line segments) and selecting Modify > Shape > 

Straighten. 

Click accuracy: Specifies how close to an item the pointer must be before Animate recognizes the item. 

Document setup 

This documentation contains information on how to quickly rig and animate a 2D character in 

Unity with the 2D Animation package and tools. The following package versions are only 

supported for the following Unity versions: 

 2D Animation package version 4.x.x - Unity 2020.1 or later 

 2D Animation package version 3.x.x - Unity 2019.3 

2D Animation and PSD Importer integration 
You can use the 2D Animation package with the PSD Importer package to easily import your 

character artwork from Photoshop into Unity for animation. The PSD Importer is an Asset 

importer that supports the import of Adobe Photoshop .psb files into Unity and generating a 

Prefab made of Sprites based on the source file and its layers (see Adobe’s documentation 

on Layer basics). 

The .psb file format has identical functions as the more common Adobe .psd format, with 

additional support for much larger image sizes. See the PSD Importer package documentation for 

more information about the importer’s features. 

Adobe Photoshop PSB format 
For character animation with the 2D Animation package, the PSD Importer package is 

required. The PSD Importer package currently only imports the Adobe Photoshop .psb format, 

and does not import the Adobe .psd format. The .psb format has identical functions as .psd, and 

is able to support larger image sizes. 

Optional Performance Boost 
When animating your characters, you can improve the runtime performance of the animated 

Sprite’s deformation by installing both the Burst and Collections packages from the Package 

Manager. This allows the 2D Animation package to use Burst compilation to speed up Unity’s 

processing of Sprite mesh deformation. 

 

With both packages installed, the Experimental Enable batching setting becomes available in 

the Sprite Skin component. As the implementation of the performance boost might contain bugs, 

you can turn the optional performance boost off by clearing the Enable batching option. 

The package has been tested with Burst version 1.4.1 and Collections version 0.9.0-preview.6. 

Sprite Skin component 

https://docs.unity.cn/Packages/com.unity.2d.psdimporter@latest
https://helpx.adobe.com/photoshop/using/layer-basics.html
https://helpx.adobe.com/photoshop/using/file-formats.html#large_document_format_psb
https://helpx.adobe.com/photoshop/using/file-formats.html#large_document_format_psb
https://docs.unity.cn/Packages/com.unity.2d.psdimporter@latest/index.html
https://docs.unity.cn/Packages/com.unity.burst@latest
https://docs.unity.cn/Packages/com.unity.collections@latest
https://docs.unity.cn/Manual/upm-ui.html
https://docs.unity.cn/Manual/upm-ui.html
https://docs.unity.cn/Packages/com.unity.2d.animation@3.2/manual/index.html#sprite-skin-component
https://docs.unity.cn/Packages/com.unity.burst@latest
https://docs.unity.cn/Packages/com.unity.collections@latest


When the character Prefab is brought into the Scene view, Unity automatically adds the Sprite 

Skin component to any Sprite that has any bone influences. This component is required for the 

bones to deform the Sprite meshes in the Scene view. 

 

Import and export formats 

Users rarely work in a single application, so it is important to support multiple input and output 

formats. Modo supports a wide range of formats for transferring data. You can read the various 

formats by opening them directly by clicking File > Open and selecting the proper file, or by 

importing it by clicking File > Import.... The difference is that opening files makes them their 

own scene, while importing merges the saved file into the current scene. 

You can save a scene to a specific format with the File > Save As or the Export command. The 

difference between them is that saving a file in a specific format replaces whatever is in memory, 

and subsequent saves continue to overwrite the saved file in the same format, while exporting 

keeps the same scene in memory, only writing the selected format to disk. Additionally, you can 

right-click on any layer in the Item List and choose the Save Selected option from the 

contextual menu for control over saving individual parts of a scene. 

The supported formats include: 

LightWave Object (.lwo): Modo reads and writes .lwo2 format for geometry, supporting a full 

array of features including UV, weight, morph and color Vertex Maps. Equivalent surfacing data 

is translated as well, when applicable. Unsupported information is encapsulated and retained, as 

long as you remain in the .lwo format. Saving to any other format discards the extra data. The 

loading and saving of LightWave's scene files is not currently supported. 

Wavefront Object (.obj): .obj is a file format developed by Wavefront Technologies for its 

Advanced Visualizer software package. The file format, being open, has been adopted by many 

other 3D applications because of its simplicity to implement, and for the most part has become a 

universal exchange format. .obj supports geometry, layers and simple surfacing. Vertex normal 

maps are also supported. The .obj format provides only a single UV map per object, and all 

vertices must be mapped (no partial UVs are allowed and they are ignored on 

export). Modo loads and saves .obj format. 

Alembic (.abc): Established by Sony Imageworks and ILM, Alembic is an open computer 

graphics interchange framework. Alembic distills complex, animated scenes into a non-

procedural, application-independent set of baked geometric results. The format currently 

https://docs.unity.cn/Packages/com.unity.2d.animation@3.2/manual/SkinEdToolsShortcuts.html#bone-influences


supports the import and export of both static and animated meshes, including subdivision 

surfaces and camera data. While the format does not directly support material information, part 

and material tags are exchanged with the mesh data. WHen importing an .abc file, the files will 

remain external to the scene, streaming in on an as-needed basis. When importing 

files, Modo displays a dialog. 

 

• Import as Static Meshes: converts the loaded scene items to the more efficient, though non-

editable Static Mesh Item type. This does not apply to items with deformations. 

• Make Instances from Matching Mesh Items: creates instances in case where identical 

meshes are encountered during loading. 

• Combine Transform and Mesh Names: with this option enabled, the resulting mesh node will 

be a combination of the names of the two items, the transform and the mesh. With it disabled, it 

will just use the name of the mesh alone. 

• Import All Frames: when loading an animated scene, enabling this option loads the 

transformations and deformations for the entire sequence. If disabled, Modo only loads the 

scene for the frame specified in Import Specific Frames. 

• Store Animated Morphs with Meshes: if enabled, Modo loads all the mesh deformations into 

the scene file directly. If disabled, the deformations are referenced from the original Alembic 

file and loaded as necessary. 

• Import Specific Frames: loads the scene with the transformations and deformations for the 

defined frames only. 

• Subdivision Level: when loading subdivision meshes, this value defines their current 

subdivisions level amount. 

Protein Database (.pdb): these files represent the three-dimensional structural data of large 

biological molecules, such as proteins and nucleic acids. PDB files are common interchange 

format for displaying these structures and can be readily found on the internet for most any 

molecule type. 

https://learn.foundry.com/modo/902/content/help/pages/layout/items/static_mesh_item.html


Scalable Vector Graphic (.svg): SVG is an open standard xml based vector image format, that 

supports both curve data and image map data. Modo reads the vector data stored in the format 

and import files as bezier curves into a scene. SVG files are generated in a vector drawing 

package such as Adobe Illustrator. Once imported the Mesh Item layer is stored in a folder 

named after the SVG file. Imported curves can be converted to Curve Polygons or converted to 

regular polygons using the 'Freeze' command. Additional enabling the render curves option will 

also make the resulting curves visible to the render engine. 

McNeel Rhino® (.3dm): Rhino is a NURBS-based 3D modeling application. It has the ability to 

internally convert its curve based NURBS models into a triangulated polygon 

model. Modo reads the triangulated polygon data from any Rhino 3DM format file 

(Modo cannot read NURBS data directly). Modo can both Read and Write to the .3dm file 

format. 

COLLADA (.dae): COLLADA™ is an open source 3D interchange format managed by the 

Khronos™ Group. The Modo COLLADA exporter can read and write geometry with normals 

and multiple UV texture coordinate sets, materials, lights, cameras, effects, and transform 

animations, all using a common technique that is compatible with a wide variety of third-party 

tools. There are a number of File I/O Preferences that support this format. 

Autodesk® fbx (.fbx): .fbx is originally a file format developed by Kaydara for their 

FiLMBOX® application, now owned by Autodesk. It has been adopted as a universal exchange 

format between digital content creation applications, because of its robust support of object and 

animation data. Modo reads and writes the libraries supplied by Autodesk, that support 

interchange of geometry, lights, cameras, basic material and surfacing, UVs and transform 

animations. 

Autodesk® dxf (.dxf): .dxf is a simplistic geometry format developed for the interchange of 

data between CAD applications. .dxf does not support surfacing, materials, Vertex Maps or 

animation. Modo both reads and writes this format. 

Web3D Standard (.x3d): .x3d is an XML-based 3D standard and is the successor to VRML on 

the internet. It supports geometry and basic surfacing. Modo is only able to write out to this 

format. 

https://learn.foundry.com/modo/902/content/help/pages/preferences/pref_fileio.html


VideoScape (.GEO): Aegis VideoScape 3D was an early 3D rendering and modeling program 

on the Amiga (precursor to LightWave). You can both read and write geometry in this legacy 

format, though it is most useful for reading, as very few modern programs support the format. 

Stereolithography (.stl): The Stereolithography format is the language of 3D printers and CNC 

milling machines, commonly used with rapid prototyping and computer-aided 

manufacturing. .stl only describes the surface of the geometry, ignoring any shading or surfacing 

values. The STL I/O preference options allow you to define how unit values are interpreted and 

what format the resulting file is written in binary format (Save as ASCII option disabled), or in 

the ASCII text format (Save as ASCII option enabled). 

Encapsulated PostScript (.eps): .eps files are a 2D vector format developed by Adobe® for 

exchange of vector drawing information created in their Illustrator® application. Though 

generally used for print applications, .eps files are imported into Modo as curvesand you can 

freeze them into faces for further manipulation, render the curves directly, or use them as a basis 

for patch modeling. Modo does not export into .eps, except for the Export UVs to EPS command 

in the menu bar: Texture > Export UVs to EPS. 

HPGL Plotter File (.plt): .plt is a 2D vector-based plotter format originally devised for use with 

AutoCAD®. Modo only exports to this format. 

 

Document and timeline window feature 

The timeline in Adobe Animate organizes and controls a document's content over time in layers 

and frames. Like a movie film, Animate documents divide lengths of time into frames. Layers 

are like multiple filmstrips stacked on top of one another, each containing a different image that 

appears on the Stage. The major components of the Timeline are layers, frames, and the 

playhead. 

https://learn.foundry.com/modo/902/content/help/pages/uving/export_uv_2_eps.html


 

The timeline shows where animation occurs in a document, including frame-by-frame animation, 

tweened animation, and motion paths. Controls in the layers section of the timeline let you hide, 

show, lock, or unlock layers, and display layer content as outlines. You can drag timeline frames 

to a new location on the same layer or to a different layer. 

Modern Timeline 

Timeline panel’s look and feel is enhanced including clear frame interval representation, better 

readability of frame and time marker, enhanced onion skinning, buttons for creating keyframes, 

blank frames and so on. 

 

Timeline controls 

Timeline header has been made richer by surfacing extra functionality upfront. 

 



LAYER VIEW 

You can toggle from the default multi-layer view to a current layer view by clicking the Layer 

view icon on the upper left. 

 

Multi-layer view 

 

Single layer view 

CAMERA 

To enable or disable camera, click the camera button. 

LAYER PARENTING VIEW 

It displays the parenting hierarchy of layers. 

LAYER DEPTH 

It creates a layer depth panel and allows you to modify the depth of active layer provided in the 

list.  

Note: 

When an animation is played, the actual frame rate is displayed. This frame rate can differ from 

the document’s frame rate setting if the computer cannot calculate and display the animation 

quickly. 

Onion skinning 

Onion skinning has been revamped and made simpler. You can enable onion skinning by 

clicking the onion skin button. Onion Skinning is further enhanced to selectively exclude (and 

include) frames by right click any onion skin frame within the onion skin range.  



 

Do one of the following: 

 Click the Onion Skin button  to enable and disable onion skinning. When enabled, All frames 

between the Start Onion Skin and End Onion Skin markers (in the timeline header) are 

superimposed as one frame in the Document window. 

 Click and hold the mouse on the Onion Skin button  to view and select the options like selected 

range, all frames, anchor markers and advance settings. 

 Select the Onion skin icon  (the icon to the left of the Loop icon) in the timeline.  

Some of the onion skin parameters in this panel are existing features like outline mode, onion 

skin previous/future frame color preference, anchor markers:. 

 Keyframe only mode: Render only keyframes in onion skin range, that is skip between frames 

of tween. 

 Starting Opacity: Opacity of first onion skin frame on either side of active frame. 

 Decrease by: Percentage delta decrease across every onion skin frame. 

 Constraints: Range of previous and next frames are same when constraints are enabled, unless, 

user edits the range from timeline. 

For more information, see Using Onion skinning. 

Some of the onion skin parameters in this panel are existing features like outline mode, onion 

skin previous/future frame color preference, anchor markers. 

https://helpx.adobe.com/in/animate/using/frame-by-frame-animation.html#main-pars_heading_2


·       Keyframe only mode: Render only keyframes in onion skin range, that is,. skip between 

frames of tween. 

·       Starting Opacity: Opacity of first onion skin frame on either side of active frame. 

·       Decrease by: Percentage delta decrease across every onion skin frame. 

Constraints: Range of previous and next frames are same when constraints are enabled, unless, 

user edits the range from timeline. 

 

Advanced Settings 

A. Opacity of first onion frame B. Decrease opacity across onion frames C. Show keyframes 

only D. Anchor markers  

Edit multiple frames 

It allows you to view and edit contents in multiple frames within the selected range. 

Click and hold the mouse on the Edit Multiple Frames button to view and select Edit selected 

range and edit all frames. Click to disable and enable the Edit Multiple Frames mode. 

 

Create tweens 

Click and hold the mouse on the Create Tween icon to view and select the options. Select the 

frame span in the timeline and click Create Tween to create a tween as per the recent selection. 



 

Changing the appearance of the timeline 

By default, the timeline appears below the main document window. To change its position, 

detach the timeline from the document window and float it in its own window. You can dock it 

to any other panel of your choice. You can also hide the timeline. 

To change the number of layers and frames that are visible, resize the timeline. To view extra 

layers when the timeline contains more layers than can be displayed, use the scroll bars on the 

right side of the timeline. 

 

Dragging the Timeline 

 To move the timeline when it is docked to the document window, drag the title bar tab at the 

upper-left corner of the timeline. 

 To dock an undocked timeline to the application window, drag the title bar tab to the top or 

bottom of the document window. 

 To dock an undocked timeline to other panels, drag the timeline title bar tab to the location you 

choose. To prevent the timeline from docking to other panels, press control key while you drag. 

A blue bar appears to indicate where the timeline will dock. 

 To lengthen or shorten layer name fields in the timeline panel, drag the bar separating the layer 

names and the frames portions of the timeline. 



CUSTOMIZING THE TIMELINE VIEW 

1. To display the Frame View pop-up menu, click Frame View in the upper-right corner of 

the Timeline. 

2. Select from the following options: 

  

 To change the size of layers, select Large, Medium, or Short. (The Large frame-width 

setting is useful for viewing the details of sound waveforms. 

 To display thumbnails of the content of each frame scaled to fit the timeline frames, 

select Preview. This preview can cause the apparent content size to vary and requires 

extra screen space. 

 To move the Timeline Controls to the top or bottom, select Header Top or Header 

Bottom, respectively. 

 To zoom in and zoom out the Timeline, use the Timeline resize view slider bar. 

 

Timeline as header 

 

Timeline as footer 

CHANGE LAYER HEIGHT IN THE TIMELINE 

1. Do one of the following: 

  

 Click the hamburger menu in the Timeline header. Select Short, Medium, or Tall. 

Double-click the layer’s icon (the icon to the left of the layer name) in the timeline.  

 Right-click (Windows) or Control-click (Macintosh) the layer name and 

select Properties from the context menu. 

 Select the layer in the timeline and select Modify > Timeline > Layer Properties. 



 

Short layer height 

 

Tall layer height 

2. In the Layer Properties dialog box, select an option for layer height and click OK. 

LAYER COLORING AND PINNING 

You can pin or color a layer for easy identification by clicking on the dot that appears just after 

the layer name. When enabled, an underline with the layer outline color appears across the layer 

for a quick layer recognition.  

 

SET LAYER OPACITY 

Do one of the following: 

 To set the visibility to opacity, use shift+click the eye column in the timeline. 

 Double-click the layer’s icon (the icon to the left of the layer name) in the Timeline. 

 Right-click (Windows) or Control+click (Macintosh) the layer name and select Properties from 

the context menu. In the Layer Properties dialog box, select Visibility>Opacity. 

 Right-click (Windows) or Control+click (Macintosh) the layer name and select Show Others as 

Transparent. 

Resize the timeline panel 

 If the timeline is docked to the main application window, drag the bar separating the timeline 

from the stage area. 

 If the timeline is not docked to the main application window, drag the lower-right corner 

(Windows) or the size box in the lower-right corner (Macintosh). 



The blue playhead at the top of the timeline moves as a document plays to indicate the current 

frame displayed on the Stage. The timeline header shows the frame numbers of the animation. 

To display a frame on the stage, move the playhead to the frame in the timeline. 

To display a specific frame when you are working with many frames, move the playhead along 

the timeline. 

 To go to a frame, click the frame’s location in the timeline header, or drag the playhead to the 

desired position. 

 To center the timeline on the current frame, click the Center Frame button at the bottom of the 

timeline. 

 Now, loop range can be created by just dragging over the loop section. It allows you to export 

the frames (as movie or video) in selected range. 

 With the loop option turned on in the timeline, you can also loop streaming audio within a range 

of frames along with other animations. 

 

Looping 

Viewing time along with frames 

The timeline displays the time in seconds along with the frame numbers. This feature allows 

faster conversion from frames to time and also keeps you aware of the frames per second (fps) 

value you have set throughout the animation process.  

In the following screenshot, the timeline displays 20 frames per second (fps):  

 

Viewing time along with frames 

Managing animation speed 

You can manage animation speed by scaling the frame spans, by animating based on time 

intervals, or you can extend and compress animations by using time controls.  



SCALE THE FRAME SPANS 

You can change frames per second (fps) for your animation without having to change the 

animation speed. Use the Scale Frame Spans option as you change fps to keep the time intact.  

 

Option to scale frame spans 

ANIMATING BASED ON TIME INTERVALS 

Turn your frame spans into 1s, 2s, 3s or to any desired interval. This feature works on classic 

tween span, shape tween span, motion tween span, keyframe span, or on a blank keyframe span. 

 

Custom frame by frame animation based on specific time intervals. 

Convert to Frame-by-Frame animation option is available in Modify menu. You can also 

assign your desired keys in keyboard shortcut dialog to perform these tasks.  



EXTEND OR COMPRESS ANIMATIONS USING TIMELINE CONTROLS 

Now, you can extend the frame duration of selected frames by entering desired number of frames 

in Expand frame span field. The duration of the selected frames are increased by the number 

entered in the Expand frame span. 

You can extend or reduce time for the selected span on the timeline. Select the frame span and 

drag the right-side edge of the selected span on timeline, forward or backward. The frames 

within the timeline are adjusted automatically. 

You can replicate your animations multiple times (x2, x3, and so on) by dragging the spans in 

timeline. You can also compress the frames to their normal position, after extending them.  

Select the frames in timeline, click, and drag the highlighted right-side edge of the selection. 

 

Frame selection and border 

While dragging, as shown in the following screenshot, you can view the animation in multiples 

such as x2, x3, and so on.  

 

Display of stretched frames while dragging. 

In the following screenshot, you can view the extended span in multiple of x2. x2 is double the 

size of a selected span. x3 is three times the original size of a span.  

 

Extended spans after dragging. 



The frame duration can now be extended by entering desired number in Expand frame 

Span field. The duration of the selected frame is increased by the number of frames entered in 

the Expand Time Span. 

Navigating in timeline 

KEYFRAME NAVIGATION 

Now, you can click the Step back one frame or step forward one frame button to move to the 

previous or next frame. Also, click and hold the mouse on the Step back one frame or step 

forward one frame button to move to the first or last frame respectively. 

Click the Play button to view the preview of your animation. 

 

You can navigate between keyframes on the active layer using the Control menu. You can also 

use Alt+. or Alt+, to move forward and backward to next or previous keyframes respectively in 

the timeline.  

 

Keyframe navigation options with keyboard shortcuts 

You can navigate between keyframes on the active layer using the left and right controls on the 

layer. Also, you can use the menu and keyboard shortcuts.  



 

Timeline displaying left and right controls on layer 

Note: 

You can use page navigation shortcuts such as Alt+Shift+, for backward and Alt+Shift+. for 

forward navigation.  

Insert frames and keyframes 

Keyframes, blank keyframes, and frames can be added by just a click of the button on the 

timeline. Click and hold the mouse on the Keyframe icon to view and select the options. Select a 

frame in timeline and click Keyframe icon to insert frame, keyframe, or blank keyframe as per 

the recent selection. 

Inserting keyframe or blank keyframe in Timeline panel now has a visual feedback. A subtle 

glow indicates that the operation has been carried out. 

 

 

Inserting keyframe or blank keyframe in Timeline panel now has a visual feedback. A subtle 

glow effect indicates that the operation has been carried out. 

Active layer only mode 

The Timeline View icon is modified with a new mode called Active Layer Only. To view only 

the active layers in the timeline, click and hold the mouse on the Timeline View option and 

select Active Layer Only.  



Panning through timeline from stage 

 Now, you can also use hand tool to slide the Timeline horizontally. 

 You can scrub the timeline right from the stage using the new time scrub tool. This tool is 

grouped with the hand tool in tool panel. You can also use spacebar+T keyboard shortcut to 

temporarily enable this tool. Drag left or right to view the timeline in the direction of pan.  

 

Display of time scrub tool 

Customizable Timeline Toolbar 

With the customizable timeline, you can choose what action buttons to be displayed in the 

timeline toolbar. In the hamburger menu of the timeline, click Customize Timeline Tools. 

 

A - Timeline Hamburger Menu B - Menu option to customize timeline toolbar 

A panel with toolbar buttons displays, which could be either added or removed from the timeline 

toolbar. Click anywhere outside the panel to close it. When the panel is open, buttons that are 

displayed on the timeline toolbar are selected in the panel. To toggle button selection, click the 

appropriate buttons. Changes are immediately shown in the timeline toolbar.  



 

A - Tools Panel B - Frame Buttons Group C - Tween Buttons Group D - Reset 

Timeline toolbar has a few options which are grouped in a single button. Long click the button to 

reveal all options grouped in the button. 

For example, Insert Keyframe or frame group button has following four options grouped under 

it: 

 Keyframe 

 Blank Keyframe 

 Frame 

 Auto Keyframe 

In the toolbar panel, the above options appear as a grouped button, and individual buttons. If a 

group button is selected, individual buttons in that group are automatically deselected. And if any 

individual button in the group is selected, the group button in deselected. 

Two such groups exist in the tool panel. One for inserting keyframes or frames, and the other for 

inserting tweens.  

There are a few buttons in the tool panel that are selected and deselected in pairs. For example, 

buttons to step keyframes backward or forward, and buttons to step single frame back and forth.  

If you want to discard any changes in the configuration panel and revert timeline toolbar to the 

default state, click Reset Timeline Controls. 

Tools and commands palettes 

1. Moho Pro 

Moho Pro is a powerful tool for creating 2D animations. If you're a professional looking for 

software compatible with your Mac devices, consider using Moho Pro. It has a Smart Bone 



feature that enhances your character's facial expressions and body turns and a powerful rigging 

system. Moho Pro also offers advanced movement options that use physics and automation to 

create realistic animated sequences. Choose between the cost-friendly Moho Debut option and 

the advanced Moho Pro package. The former is suitable for beginners, while the latter is useful 

for high-level animations. 

 

2. CelAction 2D 

CelAction 2D is a software program designed for 2D puppet/skeleton animation. It's divided into 

four editions such as Studio, Animator, Educational and Professional, making it suitable for 

every animation level. For example, the Studio Edition is an excellent choice if you're working 

with a large team to animate television series, create animated shorts and produce feature films. 

This edition includes upgraded and advanced Inverse Kinematic Toll that helps animators pose 

characters and models. CelAction 2D imports 3D CGI models and interoperates with other 

software, allowing you to choose the ideal software for your production tools. 

3. Procreate 

Procreate is a powerful and intuitive software that uses frame-by-frame animation techniques. It 

gives animators the benefits of working digitally while recreating familiar experiences of pens, 

pencils and paint on paper, making it ideal for beginners. If you're an animator looking for a 

deceptively powerful animation tool in the palm of your hand, consider using Procreate. With its 

Animation Assist feature, you can sketch animatics, make looping GIFS and create beautiful 

animations with your iPad. It also has a ColourDrop feature to quickly add colour to your work 

and an extra special FX to add gorgeous finishing touches. 

4. Autodesk Maya 

Autodesk Maya is a professional 3D animation tool for creating realistic images and virtual 

visual effects like water and explosions in a single visual program. Whether you're animating 

lovable cartoon characters or lifelike Digi doubles, Maya has the animation toolset to bring your 



characters to life. It uses modelling features such as Quad draw Toolset to intuitively draw 

polygons directly on the surface of models and Soft Selections features to smoothly alter the 

geometry. Use its Shape Editor features to change the topology for each face and the Component 

Mode tool to control individual verticals. 

5. Cartoon Animator 

Cartoon Animator is a versatile software that professionals use to draw original 2D animations. 

The software allows you to choose a character from its database and import PSD character 

templates, creating custom 2D characters. Create various animations from IK motion editing to 

full-body capture using Cartoon Animator features. For example, use its sprite-based facial 

system to transform a 2D face into a 3D talking head. It also has a rigging and bone tool that 

animators use to create believable multi-angled 2D characters. 

6. Adobe Character Animator 

Adobe Character Animator is software that helps animators create high-quality animations that 

professionals use for live performance. It has the tools you require to quickly and efficiently 

animate your 2D characters, from lip-syncing to motion capture technology. With its seamless 

Photoshop and Illustrator, create your characters using your favourite tools and bring them to life 

using Character Animator. Animators use Adobe Character Animator to import and animate 

characters using a combination of live motion- capture and multi-track recording. It can also 

function as a powerful stand-alone app that creates interactive humanoid animations. 

7. Clip Studio Paint 

Clip Studio Paint is an animation solution that allows you to create 2D animation, comics and 

general illustrations. It has a simple timeline interface, which you can easily tweak to increase 

the speed of your animation and rearrange the animation cells. Clip studio paint also allows 

professionals to combine frame-by-frame animation with camera effects so that you can create 

stunning full-length animation. With Clip Studio, adjust your pen pressure to recreate natural, 

high-quality lines of paper and pen. Use its 3D references for accurate composition and draw 

frames between keyframes. 



8. Adobe Animate 

Adobe Animate is an animation solution that helps animators create interactive content, 3D 

animations and 2D drawings. Professionals use the software to create interactive 2D animations 

and vector graphics for ads, games and television. Adobe Animate has a timeline control that 

allows you to create characters, shapes and avatars. It has a clean and recognisable interface and 

the ability to quickly share and publish work to social platforms, making it easy to get your 

animations online. With Adobe Animate, synchronise audio with your animations, create audio 

loops and access premium web fonts using Typekit integration. 

9. Blender 

Blender is an open-source video editing software that allows animators to have total control over 

animations. The tool offers advanced programming features and a command line for modelling, 

rendering and creating 3D animations. Blender is compatible with multiple devices such as 

Windows, Linux and Mac. If you're looking for animation software for pro editing and creating, 

consider using Blender. It has video editing and VFX features that you can use to track, mask 

and compose animations. Blender has a customisable user interface that animators use to 

navigate and an extensive Python API for scripting. 

10. Synfig Studio 

Synfig Studio is an open-source software for creating 2D animated videos. The app interface 

allows users to draw using keyboard shortcuts. Synfig Studio offers advanced controls that help 

you link parameters of various layers to create dynamic structures and advanced character 

puppets. With Synfig Studio, use over 50 layers and choose a variety of layer types like filters, 

distortions, transformations and gradients. It also has a full-featured bone system that you can 

use to rig your vector artwork and create cutout animation using bitmap images. 

11. Open Toonz 

Open Toonz is a free animation software professionals use for commercial and non-commercial 

2D animation projects. It's open-source, meaning you can change the source code to improve 



your experience. It has indexed colour palettes for quick paint and colour change and a scan and 

clean-up feature to create vectors from paper drawings. Combine your animations with video 

footage to track their motions and link objects to execute complex movements through motion 

tweening. Use vector and bitmap tools to draw digital 2D animation and create particle systems 

like rain and dust. 

 

12. Pencil2D 

Pencil2D is a free, open-source software ideal for 2D hand-drawn animations. The software is 

beginner-friendly, and its user interface is intuitive. The UI has a simple drag and drop function 

and a customisable workflow, allowing image tracing. Pencil2D also supports layer-by-layer 

creation techniques making it simple to use. It has onion skinning and bitmap drawing features 

for making cartoons and colourful 2D designs. Pencil2D functions across multiple platforms and 

offers animators numerous virtual drawing tools, including ink, paint and pencil. This helps 

artists create animated versions of their vision in various style options. 

13. Spine 

Spine is a 2D animation software program for games. The tool allows animators to import 

drawings and animate them using various specialised features. These features include free-form 

deformation tools, which artists use to change the shape of an image and texture packers, 

allowing you to render specific textures in your game efficiently. It also has a dope sheet to 

adjust timing, ghosting features to visualise motion and inverse kinematics to pose characters in 

a game. Professionals use Spine to create 2D skeletal animation, providing them with an efficient 

workflow for integrating into games and creating amazing animation. 

14. Piskel 

Piskel is a free online software editor for pixel art and animated sprites. It allows animators to 

create 2D images made from low-definition pixels. This results in animated characters that 

resemble those from traditional pixelated video games. Piskel technology allows animators to 



adjust their frame rates to create live previews of their work. With Piskel, export animated GIFs 

and full-length projects like Piskel features open-source code and Open Toonz. The tool supports 

free desktop and offline applications for OSX, Linux and Windows. 

 

Media-selection tools and techniques 

Animation is the process of transforming still images into moving images. When still images are 

displayed rapidly on media, such as film or video, they create the illusion of motion. 

Animators are digital artists with competencies that include conceptual design, drawing, creative 

development, and curiosity. They also use animation tools and software. The following list offers 

a glimpse of the tools animators use: 

1. 3ds Max (Autodesk). This commercial animation software tool allows digital artists to produce 

3D animations, including developing models and rendering them into 2D or 3D images. 

2. After Effects (Adobe). Digital artists can use this commercial tool to add visual effects and 

motion graphics elements to film, TV, video, online content, presentations, and more. 

3. Animate (Adobe). Users can create animations across multiple media, from cartoons and banner 

ads to interactive content for games, TV shows, academic content, and infographics. 

4. Blender (The Blender Foundation). This free open source 3D graphics creation suite offers a 

comprehensive feature set to create animations, digital art, visual effects, 2D and 3D models, and 

more. 

5. Cartoon Animator 4 (Reallusion). Digital artists across TV, film, web, and game development 

using this versatile animation tool can create 2D animation with 3D motion. 

6. Character Animator (Adobe). Digital artists can use their own movements and expressions to 

create animated characters in real time. 

7. Dragonframe (DZED Systems). The advanced image capture interface of this tool is popular 

among digital artists in the movie industry for stop motion animation, motion design, and visual 

effects. 

8. FlipBook (DigiCel). Whether drawing with a stylus and tablet or using pen and paper, this 

animation software offers digital artists intuitive tools to create 2D animations. 

9. Maya (Autodesk). This commercial software provides digital artists with a comprehensive 

platform and an extensive feature set, including modeling, simulation, and rendering, to create 

3D computer animations. 

https://www.autodesk.com/products/3ds-max/overview?support=ADVANCED
https://www.techopedia.com/definition/9163/rendering
https://www.adobe.com/products/aftereffects.html
https://www.adobe.com/products/animate.html
https://www.blender.org/
https://www.reallusion.com/cartoon-animator/download.html
https://www.adobe.com/products/character-animator.html
https://www.dragonframe.com/
https://digicel.net/
https://www.autodesk.com/products/maya/overview?support=ADVANCED&plc=MAYA&term=1-YEAR&quantity=1


10. Moho Pro 13 (Smith Micro). Formerly known as Anime Studio, this vector-based 2D 

animation software gives digital artists various tools to create animations and cartoons, including 

2D and 3D characters. 

11. Moovly (Moovly). The novice and expert can use this cloud-based software to create animated 

videos and videos with animated graphics for various applications, including marketing and 

training. 

12. OpenToonz (Digital Video SpA). This software tool allows digital artists to create 2D 

animations. As open source software, it’s free to use, anyone can modify its source code, and it’s 

frequently updated. 

13. Pencil2D. For digital designers interested in using traditional drawing techniques, this open 

source software allows users to create 2D cartoons using both bitmap and vector graphics. 

14. PhotoMirage (Corel). Corel, the developer of the world’s first full-featured graphics suite, 

continues to build innovative tools. For example, PhotoMirage is an animation tool that enables 

users to combine still images with motion graphics. 

15. Piskel. This free online editor allows digital artists to create animations reminiscent of the pixel 

art in video games created in the 1980s. 

16. Powtoon (Powtoon).This cloud-based animation software for digital artists and amateurs alike 

in business, education, and other sectors allows users to create animated explainer videos, 

demos, and presentations. 

17. Spine (Esoteric Software). For digital artists interested in gaming, this software offers users the 

tools to create 2D animation for games, as well as 3D effects. 

18. Stop Motion Studio (Cateater). This software provides an intuitive interface. Its features 

include frame-by-frame editing to allow digital artists of all ages to create stop motion movies 

using a desktop or phone app. 

19. Synfig Studio. Open source software such as Synfig Studio provides users with a host of 

features to create 2D vector-based animations, and it’s free to use. 

20. Harmony 20 (Toon Boom). This popular 2D software tool includes end-to-end features to 

enable digital artists to create animations, from conception to final production. 

21. TVPaint Animation (TVPaint Development). For animators who may want to draw on paper, 

this 2D software, based on bitmap technology, allows artists to create animations using 

traditional and digital methods. 

https://my.smithmicro.com/moho-pro.html
https://my.smithmicro.com/moho-pro.html
https://www.moovly.com/
https://opentoonz.github.io/e/
https://www.pencil2d.org/
https://www.photomirage.io/en/
https://www.piskelapp.com/
https://www.powtoon.com/
http://esotericsoftware.com/
https://www.cateater.com/
https://www.synfig.org/
https://www.toonboom.com/products/harmony
https://www.tvpaint.com/v2/content/article/feature/animation2d.php


Asset-management features. 

 

What is digital asset management? 

A digital asset management solution is a software and systems solution that provides a 

systematic approach to efficiently storing, organizing, managing, retrieving, and 

distributing an organization’s digital assets. Digital Asset Management (DAM) can be used 

to refer to both a business process and a form of information management technology, or a 

digital asset management system. DAM functionality helps many organizations create a 

centralized place where they can access their media assets. 

The digital asset is a key component of the DAM process. It is any file type of value that is 

owned by an enterprise or individual, comes in a digital format, is searchable via metadata, 

and includes access and usage rights. There are many types of digital assets, including but 

not limited to: 

 Documents 

 Images 

 Audio content 

 Video 

 Animations 

 Media files 

 Graphics 

 Presentations 

 Any digital media that includes the right to use 

A DAM solution streamlines asset management and optimizes the production of rich media, 

particularly within sales and marketing organizations, by creating a centralized 

management system for digital assets. It enables brand consistency through automatic 

asset updates and reinforcement of brand guidelines, providing a single source of truth 

within businesses and a more consistent user experience to external audiences. Modern 

digital content management teams and marketers also rely on DAM to repurpose content, 

reducing unnecessary production costs and duplicate workstreams with its invaluable 

search features. Given the high visibility of brand assets and marketing assets through 

digital channels, like social media, it’s important for brands to remain consistent in imagery 



and messaging to build brand authority and generate business growth. As a result, it’s no 

surprise that digital asset management platforms are becoming critical components of 

digital transformation efforts. 

How DAM software works 

Several steps are involved in the use of a DAM solution: 

1. Creating the asset: Standardized templates and file formats prepares digital files for 

encoding even before they are created. This standardization improves the ease of 

document search and retrieval. 

2. Encoding and Indexing: To simplify the search for assets, metadata enables the 

identification of digital content through attributes such as asset type (e.g. 

whitepaper), version (e.g. new), media type (e.g. video), and technology used (e.g. 

Photoshop, etc.). These identifiers create an index, grouping assets that have 

common tags to improve searchability. 

3. Workflows: This indexing can then be leveraged for rule-driven workflows, enabling 

task and process automation. 

4. Version control: Version control becomes increasingly important to automate 

workflows, as it ensures that the latest, most up-to-date asset is being utilized 

within existing one. As new workflows are established, it also ensures that only the 

most current version is accessed and carried forward for review and use. 

5. Governance through permissions: Governance through permissions ensures that 

only those who have been granted access are able to use the asset in the manner in 

which it was assigned to them. This capability protects organizational assets from 

theft, accidental corruption, or erasure. 

6. Auditing: An audit should be conducted internally to evaluate the effectiveness of 

DAM and identify areas of improvement. Likewise, regulatory bodies may audit a 

DAM solution to ensure an organization’s technology and processes comply with 

regulations. Both types of audits occur regularly in highly regulated industries such 

as finance and healthcare. 

A DAM solution can be implemented on-premises, in the cloud, or in a hybrid topology. 

Cloud-based asset storage, management and delivery can be a cost-effective, secure, 

scalable, and flexible option for an organization. 



 

The benefits of DAM 

 Reduction of production costs and better resource allocation. The centralization of 

assets within a DAM enables organizations to find and reuse assets, reducing 

production costs and duplicate workstreams. Reduced costs encourage the 

allocation of resources in other areas of the business. The resulting efficiency gains 

help to bring assets and solutions to the market faster. 

 More organizational transparency. Since a DAM provides users with a clear, 

comprehensive view of digital assets, this has implications around content planning 

and execution. It can increase collaboration across various stakeholders or 

introduce more impactful workstreams through the elimination of redundant 

projects. 

 Increased conversion and customer retention. When businesses organize content 

appropriately based on the user’s stage of the buyer journey, they can serve content 

and marketing materials at the right time for their target audiences. DAM enables 

organizations to personalize the customer experience, establishing and nurturing 

stronger relationships which moves potential customers and existing customers 

along the buying cycle faster and more effectively. 

 Brand Consistency. DAM helps to ensure that messaging, positioning, visual 

representation, and other means of brand adherence are consistent. With DAM, 

functional areas and business units can re-use creative files and other assets to gain 

efficiencies and present a single truth to the market. 

 Governance and compliance. Licenses, legal documentation, archives, and other 

assets can play key roles in meeting industry-driven or governmental regulatory 

compliance demands. The ability to organize and rapidly retrieve these materials 

can save organizations time and money, as well as mitigate the disruption of core 

business processes. 

 

The history and future of DAM 

The emergence of desktop publishing in the late 1980s enabled printers, publishers and 

advertisers to digitize text, graphics and photography. Too big for most internal hard 



drives, these files were transferred to external media with simple metadata labels. They 

were placed in simple, hierarchical files and folders. 

In 1992, Canto Software released Cumulus — one of the first DAM systems. It was an on-

premises, standalone solution, featuring thumbnail previewing, metadata indexing and 

search capabilities. While early DAM solutions made assets easy to find, verify, and 

retrieve, files were still not easy to share. 

By the early 2000s, server-based DAM enabled file-sharing over the Internet. Shortly 

thereafter, cloud storage offered another way to store, manage and distribute digital assets. 

DAM quickly evolved into integrated libraries able to deliver content to a variety of devices, 

systems, and repositories. Application programming interfaces (APIs) enabled assets to 

plug into different applications and meet specific requirements quickly and efficiently. 

Now it is common for AI capabilities to be embedded into DAM — intelligently tagging and 

cross-referencing assets, including video recognition and voice recognition. IBM Watson 

Video Enrichment can analyze video streams using deep learning technologies while the 

IBM Blockchain Platform ensures greater DAM security. Using machine learning, DAM 

systems can anticipate content needs and make recommendations to users. With these 

marketing tasks being performed very quickly, often within minutes or less, organizations 

can make adjustments in near-real time to gain a competitive advantage. 

 

What to look for in a DAM solution 

When looking at DAM platforms, it is important to evaluate whether the solutions you 

select provide capabilities that will help you implement a successful solution to support 

your needs today and beyond. A successful DAM solution will provide the following 

capabilities: 

 Support asset lifecycle and role-based permissions: Your DAM solution should 

enable you to manage your digital assets from idea through conception and 

throughout their lifecycles. It should also provide access rights and permissions 

with the granularity that you need to preserve the integrity of your assets. 

 Integration: Your DAM solution should integrate with the solutions that you have in 

place today, such as asset creation and distribution, and any systems you plan to add 

in the future. 



 Bidirectional flexibility: A flexible, agile DAM solution will provide the flexibility to 

search for assets in any direction. Bidirectional flexibility enables you to search 

metadata, such as brand, to find an asset, or search specific assets to find metadata. 

This capability supports the search and repurposing of assets by other functional 

groups within an organization. 

 Import and export capability: Your DAM solution should not create an isolated 

island of data. Your ideal solution should include the ability to share digital assets as 

well as search results and other data. 

 Stable storage and transfer infrastructure: The DAM solution you choose is equally 

as important as how and where the assets are stored, and the ability to transfer the 

assets wherever they are needed. Whether you choose on premises software-

defined storage or cloud-based storage, consider the reliability, flexibility, 

scalability, performance, and recoverability to protect your assets. 

 File transfer efficiency: Speed and efficiency of file transfer are important because 

they directly affect your speed of business. The ability to share and use the assets 

when and where you need them will help to define the effectiveness of the solution 

that you choose. 
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